Ques. 1. What are the skills a finance specialized student should have?

Traditionally, a finance student was expected to be well versed in knowing the various financial tools to carry on the work in hand. He/she had to execute the job within the iron boundaries of financial management. Now, finance has also attracted innovative ideas. The finance student should have the capability to take decisions which are beyond the text books and now more pertinently, beyond the ‘Google search engine’. If a finance student is aware of the happenings in the global scenario he/she is likely to provide solutions to seemingly ‘systemic problems’. Use of web and networking allows the student to do that.

Ques. 2. What all are the areas where generally student lack and should focus upon?

The students generally lack the exposure to ‘unforeseen financial situations’ and are found to be unaware to the remedies available. The solution to these issues is that the students should be clear in their mind as to ‘what do they stand for, what is their ultimate aim’. For that, students should have more policy oriented readings and case studies at their disposal.

Ques. 3. How would you describe the picture across the region in terms of the global financial crisis?

The global scenario post financial crisis has been that of ‘cautious optimism’ but the speed of reforms is fairly slow. The resistance from U.S. congress to pursue further state run programs seems to have given a jolt to the market sentiments. However, given the strong fundamentals of Indian economy and timely interventions from financial apex bodies like RBI, IRDA, SEBI et al, we are much better placed as compared to U.S.A. and East European countries.

Ques. 4. What is the relationship between risk and return?

The relationship between risk and return is that they both are positively correlated. One cannot expect high returns if the risks are low. If, however, big returns are realized in ventures where risk was appreciably lower, then it has to either a case of ‘information imperfections’ or that of ‘sealed entry’ causing such a win-win situation to investor/business person.

Ques. 5. Scope of finance as a career choice?

Finance has tremendous scope in the time to come. What I foresee is that ‘Finance’ as a discipline would be supplemented with host of other disciplines/tools such as Information Technology, Risk Management tools.
1. Billionaire Mark Cuban: **There are no shortcuts.**

The best advice he ever got was: "Do the work. Outwork. Out-think. Out-sell your expectations. There are no shortcuts." The advice came from his father, who did upholstery on cars, when Cuban was in high school. "He was always very encouraging but also realistic," Cuban says of his dad.

2. Entrepreneur and author Tim Ferriss: **You are who you associate with.**

"The best advice I ever got is: You’re the average of the five people you associate with the most," Ferriss, author of the best-selling book "The 4-Hour Workweek". He got the advice from a wrestling coach when he was in high school, and has never forgotten it. "I use it always, whether it’s choosing startups to invest in, choosing investors, sports teams to join, or people to have dinner with. Constantly, I think about this."

3. Hello Design CEO David Lai: **Your time is a precious commodity.**

"When I was growing up my father would always tell me, 'We all only have 24 hours a day. It's what we choose to do with that time that defines us, It's the one thing you can never get back.'"

4. Real estate mogul Barbara Corcoran: **My best advice was an insult.**

Call it reverse psychology, but it was an insult that motivated Corcoran to succeed. "It's kind of weird. The best advice was the worst advice. It was from my boyfriend and partner in my first business when he told me I would never succeed without him. I was injured no doubt. But thank God he insulted me because I would not have built a big business without that. It kept me trying everything because I couldn't give him the satisfaction of seeing me fail. So the best advice was an insult."
1. The average age of P, Q, R, and S is 30 years. How old is R?
   I. The sum of ages of P and R is 60 years.
   II. S is 10 years younger than R.
A. I alone sufficient while II alone not sufficient to answer
B. II alone sufficient while I alone not sufficient to answer
C. Either I or II alone sufficient to answer
D. Both I and II are not sufficient to answer

**Explanation:**

\[ P + Q + R + S = (30 \times 4) \]
\[ P + Q + R + S = 120 \text{ ... (i)} \]

I. \[ P + R = 60 \text{ ... (ii)} \]
II. \[ S = (R - 10) \text{ ... (iii)} \]

From (i), (ii) and (iii), we cannot find R.

Hence, the correct answer is (D).

2. How many candidates were interviewed everyday by the panel A out of the three panels A, B, and C?
   I. The three panels on average interview 15 candidates everyday.
   II. Out of a total of 45 candidates interviewed everyday by the three panels, the number of candidates interviewed by panel A is more by 2 than the candidates interviewed by panel C and is more by 1 than the candidates interviewed by panel B.

A. I alone sufficient while II alone not sufficient to answer
B. II alone sufficient while I alone not sufficient to answer
C. Either I or II alone sufficient to answer
D. Both I and II are not sufficient to answer
E. Both I and II are necessary to answer

**Explanation:**

I. Total candidates interviewed by 3 panels = \((15 \times 3) = 45\).

II. Let \(x\) candidates be interviewed by C.

Number of candidates interviewed by A = \((x + 2)\).
Number of candidates interviewed by B = \((x + 1)\).

\[ x + (x + 2) + (x + 1) = 45 \]
\[ 3x = 42 \]
\[ x = 14 \]

Hence, the correct answer is (B).

---

**FREQUENTLY ASKED QUESTIONS**

1. A future amount that has been discounted to time period 0 becomes a …………… value.
2. Interest earned on interest is referred to as the …………… of interest.
3. The name associated with the amount removed from a future value when discounting it to the present value is ……………
4. In the calculation of present values, the future amounts that are discounted are not accrual accounting amounts; rather they are future …………… amounts.
Excel 2010
Working with Sparklines

Creating Sparklines

Sparklines were introduced in Excel 2010 to be a convenient alternative to charts. Unlike a traditional chart, a sparkline is placed inside a cell, allowing you to easily create a large number of sparklines (for example, one on each row).

Types of Sparklines

There are three different types of sparklines: Line, Column, and Win/Loss. Line and Column work the same as line and column charts. Win/Loss is similar to Column, except it only shows whether each value is positive or negative, instead of how high or low the values are. All three types can display markers at important points, such as the highest and lowest points, to make them easier to read.

To Create Sparklines:

Generally, you will have one sparkline for each row, but you can create as many as you want in any location you want. Just like with formulas, it’s usually easiest to create a single sparkline and then use the fill handle to automatically create the sparklines for the remaining rows.

1. Select the cells that you will need for the first sparkline. In this example, we are creating a sparkline for Kathy Albertson, so we will select her sales data.

2. Click the Insert tab.

3. In the Sparklines group, select Line. A dialog box will appear.

4. Make sure the insertion point is next to Location Range.
5. Click the cell where you want the sparkline to be. In this example, we’ll select the cell to the right of the selected cells.

6. Click OK. The sparkline will appear in the document.

7. Click and drag the fill handle downward.

8. Sparklines will be created for the remaining rows.

Changing the Appearance of Your Sparklines

To Change the Style:
1. Select the sparklines that you want to change.
2. Locate the Style group in the Design tab.
3. Click the More drop-down arrow to show all of the available styles.
4. Select the desired style.
5. The sparklines will update to show the selected style.
To Change the Sparkline Type:
1. Select the sparklines that you want to change.
2. Locate the Type group in the Design tab.
3. Select the desired type (Column, for example).

4. The sparkline will update to reflect the new type.

Changing the Display Range

By default, each sparkline is scaled to fit the maximum and minimum values of its own data. This allows it to fill the entire cell no matter how high or low the values are. However, it has a downside. If you are trying to compare several sparklines, you won’t be able to tell at a glance which ones have higher or lower values. The solution is to make the display range the same for all of the sparklines.

To Change the Display Range:
1. Select the sparklines that you want to change.
2. In the Design tab, click the Axis command. A drop-down menu will appear.
3. Under Vertical Axis Minimum Value Options and Vertical Axis Maximum Value Options, select Same for All Sparklines.

4. The sparklines will update to reflect the new range.
# EXCEL SHORTCUTS

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+1</td>
<td>Displays the Format Cells dialog box.</td>
</tr>
<tr>
<td>CTRL+2</td>
<td>Applies or removes bold formatting.</td>
</tr>
<tr>
<td>CTRL+3</td>
<td>Applies or removes italic formatting.</td>
</tr>
<tr>
<td>CTRL+4</td>
<td>Applies or removes underlining.</td>
</tr>
<tr>
<td>CTRL+5</td>
<td>Applies or removes strikethrough.</td>
</tr>
<tr>
<td>CTRL+6</td>
<td>Alternates between hiding objects, displaying objects, and displaying placeholders for objects.</td>
</tr>
<tr>
<td>CTRL+8</td>
<td>Displays or hides the outline symbols.</td>
</tr>
<tr>
<td>CTRL+9</td>
<td>Hides the selected rows.</td>
</tr>
<tr>
<td>CTRL+0</td>
<td>Hides the selected columns.</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Selects the entire worksheet. If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second time selects the current region and its summary rows. Pressing CTRL+A a third time selects the entire worksheet. When the insertion point is to the right of a function name in a formula, displays the Function Arguments dialog box. CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is to the right of a function name in a formula.</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>Applies or removes bold formatting.</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copies the selected cells. CTRL+C followed by another CTRL+C displays the Clipboard.</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Uses the Fill Down command to copy the contents and format of the topmost cell of a selected range into the cells below.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Displays the Find and Replace dialog box, with the Find tab selected. SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action. CTRL+SHIFT+F opens the Format Cells dialog box with the Font tab selected.</td>
</tr>
<tr>
<td>CTRL+G</td>
<td>Displays the Go To dialog box. F5 also displays this dialog box.</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Displays the Find and Replace dialog box, with the Replace tab selected.</td>
</tr>
<tr>
<td>CTRL+I</td>
<td>Applies or removes italic formatting.</td>
</tr>
</tbody>
</table>
1. **Bajaj Auto** - The Bajaj Group is amongst the top 10 business houses in India. Its footprint stretches over a wide range of industries, spanning automobiles (two-wheelers and three-wheelers), home appliances, lighting, iron and steel, insurance, travel and finance. The group’s flagship company, Bajaj Auto, is ranked as the world’s fourth largest two- and three-wheeler manufacturer and the Bajaj brand is well-known across several countries in Latin America, Africa, Middle East, South and South East Asia.

- Founded – November 29, 1945
- Founder – Jamnalal Bajaj
- Headquarters – Pune, Maharashtra, India

2. **Micromax** - Micromax Informatics Limited is one of the leading consumer electronics company in India and the 11th largest mobile phone player in the world. Over the past decade, Micromax has pioneered the democratization of technology in India by offering affordable innovations through their product offerings and removing barriers for large scale adoption of advanced technologies.

Micromax is currently the 2nd largest smartphone company in India with a market share of 19.2 percent in Q2 of 2013. The brand’s product portfolio embraces more than 60 models today, ranging from feature rich, dual SIM phones, 3G Android smartphones, tablets, LED televisions and data cards.

- Founded – 1999
- Founders – Rahul Sharma, Sumeet Arora, Vikas Jain
- Headquarters – Gurgaon, Haryana, India

3. **LinkedIn** - Founded in 2003, LinkedIn connects the world’s professionals to make them more productive and successful. With more than 259 million members worldwide, including executives from every Fortune 500 company, LinkedIn is the world’s largest professional network on the Internet. The company has a diversified business model with revenue coming from Talent Solutions, Marketing Solutions and Premium Subscriptions products. Headquartered in Silicon Valley, LinkedIn has offices across the globe.

**Specialties**
- Online Professional Network, Jobs, People Search, Company Search, Address Book, Advertising, Professional Identity, Group Collaboration

- Founded – March, 2006
- Founder – Evan Williams, Noah Glass, Jack Dorsey, Biz Stone
- Headquarters – San Francisco, CA, USA

4. **Wipro** - Wipro Infotech is a leading manufacturer of computer hardware and provider of IT services in India and the Middle East region. Part of Wipro Ltd, the $6.98 billion conglomerate and global leader in technology enabled solutions, the company leverages on the parent's philosophy of 'Applying Thought' to enable business results by being a transformation catalyst.

- Founded – 1945, India
- Founder – M. H. Premji
- Headquarters – Bangalore, Karnataka, India
Financial Markets : A Beginner’s Module

This is a basic level programme for those who wish to either begin a career in the financial markets in India or simply learn the fundamentals of capital markets. The course is structured to help understand the basic concepts relating to different avenues of investment, the primary and the secondary market, the derivatives market and financial statement analysis.

Why should one take this course?
- To get a basic understanding of the products, players and functioning of financial markets, particularly the capital market.
- To understand the terms and jargons used in the financial newspapers and periodicals.

Who will benefit from this course?
- Students
- Teachers
- Investors
- Employees of BPOs/IT Companies
- Employees of Brokers/Sub-Brokers
- Housewives
- Anybody having interest in the Indian securities market

Test details
Duration: 120 minutes
No. of questions: 60
Maximum marks: 100, Passing marks: 50 (50%); There is no negative marking in this module.
Certificate validity: For successful candidates, certificates are valid for 5 years from the test date.

Currency Derivatives : A Beginner’s Module

This module has been designed with a view to improve awareness about the ‘Currency Derivatives’ product, which has been made available for trading in the Indian securities market in 2009. The course content is structured to help a beginner understand what the product is, how it is traded and what uses it can be put to.

Why should one take this course?
- To understand the fundamentals of the currency market.
- To understand the currency futures as a risk management tool.
- To learn about the trading platform of the currency derivatives segment of a stock exchange.

Who will benefit from this course?
- Students
- Teachers
- Bankers
- Corporate Executives
- Employees of Export/Import Houses
- Analysts
- Employees of Brokers and Sub-brokers
- Anybody having interest in the Indian Securities Market

Test details
Duration: 120 minutes
No. of questions: 60
Maximum marks: 100, Passing marks: 50 (50%); There is no negative marking in this module.
Certificate validity: For successful candidates, certificates are valid for 5 years from the test date.
ARS Exam 2014

ARS Exam 2014 - Agricultural Research Services acronym as ARS Exam is conducted by the ASRB of Indian Council of Agricultural Research (ICAR) for appointment as Scientists in Agricultural Research Service (ARS) of Indian Council of Agricultural Research in the pay scale of Rs. 15,600 - Rs, 39,100 plus research Grade Pay of Rs. 6,000 in the ICAR (Indian Council of Agricultural Research) Institutes.

ARS Exam Eligibility

Eligibility Criteria

1. Educational Qualification
   For Agricultural Research Service Test a candidate must have a Master’s degree or equivalent in the concerned subject.

2. Age
   A candidate must have attained the age of 21 years but not have attained the age of 32 years as on the respective year of the exam.

On job candidates of ICAR less than 45 years in age but not State Agricultural Universities less than 35 years in age as on the respective year will also be eligible to appear subject to possession of prescribed qualifications.

ARS Exam Pattern

ARS Exam consists of two stages i.e Preliminary Exam followed by Main Exam and Vice Voca as given below.

Preliminary Exam

Main Exam consists of three parts as given below:

<table>
<thead>
<tr>
<th>Subject</th>
<th>Type of Questions</th>
<th>No of Questions</th>
<th>M.Marks</th>
<th>Timming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part A</td>
<td>Very short answer type of question-10 words</td>
<td>40</td>
<td>03</td>
<td>2 hrs</td>
</tr>
<tr>
<td>Part B</td>
<td>Short answer type of question 1 or 2 paragraph</td>
<td>20</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Part C</td>
<td>Essay type or descriptive type</td>
<td>6</td>
<td>03</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>240</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Answers are required to be written in the space provided below the question in no case extra sheets will be provided.

ARS Exam Fee

Prospective candidates have to pay Rs. 480 Plus registration charge of Rs. 20/-

ARS Exam Dates

ARS Preliminary Exam is generally held in the month of February every year.

ARS Exam Contact Details

The Secretary
Agricultural Scientists Recruitment Board krishi Anusandhan Bhavan Pusa, New Delhi– 110012
Online Marketing job description

Online Marketing professionals are required to combine their efforts with other areas such as technical support, creative services, and sales in order to plan and execute marketing campaigns. They are responsible for the use of marketing strategies on internet and mobile devices. These professionals can manage a Twitter or Facebook profile in the name of a company, publishing new content and news related to that business on a daily basis in order to obtain new clients.

Online Marketing professionals usually perform some of the following tasks:
- Creating and sending email campaigns.
- Optimizing web content for SEO strategies.
- Updating social media profiles.
- Advising about new trends.
- Managing the development and launch of display advertisements.

Skills
- Having good written and spoken communication abilities.
- Being self motivated and flexible.
- Having critical thinking.
- Being independent.
- Being able to work on several projects at the same time.
- Having high attention to details.
- Having teamwork skills.
- Having networking abilities.
- Being able to understand social media.
- Having problem solving skills.

Responsibilities
- Plan and execute all web, SEO/SEM, marketing database, email, social media and display advertising campaigns
- Design, build and maintain our social media presence
- Measure and report performance of all digital marketing campaigns, and assess against goals (ROI and KPIs)
- Identify trends and insights, and optimize spend and performance based on the insights
- Brainstorm new and creative growth strategies
- Plan, execute, and measure experiments and conversion tests
- Collaborate with internal teams to create landing pages and optimize user experience

Requirements
- BS/MS degree in marketing or a related field
- X+ years of experience in digital marketing
- Demonstrable experience leading and managing SEO/SEM, marketing database, email, social media and/or display advertising campaigns
- Highly creative with experience in identifying target audiences and devising digital campaigns that engage, inform and motivate.
III. The deposit insurance facility of the Deposit Insurance and Credit Guarantee Corporation is not available for NBFC depositors. Which among the above Statement(s) is/are not correct?

A. Only I
B. I and III
C. All of them
D. None of them

1. Which among the following is the oldest Public Sector Bank of India?
   A. Punjab National Bank
   B. Imperial Bank of India
   C. Allahabad Bank
   D. Central Bank of India

2. Which among the following Public Sector Undertaking (PSUs) is the ‘fifth’ company which has been accorded the ‘Maharatna’ status?
   A. Coal India Limited (CIL)
   B. Gas Authority of India Limited (GAIL)
   C. Power Grid Corporation of India Limited
   D. Bharat Heavy Electricals Limited (BHEL)

3. Consider the following Statements regarding Non-Banking Finance Institutions (NBFCs):
   I. NBFCs can also engage in Micro-Finance Activities
   II. Housing-finance companies from a distinct sub-group of the NBFCs.

FINVEST which symbolize finance and investment is a student managed club and it aims to spread knowledge to all those who aspire to learn the Nitty gritty of Finance. The uniqueness about this club is its focus on practical aspects of finance and regular research by students which keeps them updated with the changing scenario.